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Section 4. EXERCICES DE LABORATOIRE  

4.1  Exercice 1 - Affichage des donn es g ographiques 

Objectifs d apprentissage : 
 tre capable d ajouter des couches   ArcMap 
 tre capable de symboliser les couches 
 tre capable de sauvegarder et ouvrir le document cartographique

4.1.1 Ajouter des couches   ArcMap  
D marrer ArcMap [Menu D marrer de Windows> Tous les programmes> ArcGIS> 
ArcMap 10] 

Une fen tre ArcMap 10 sans titre et ArcMap - La fen tre de d marrage appara t. Cliquez 
sur le bouton   Annuler   pour supprimer la fen tre ArcMap - Fen tre de d marrage. 
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Cliquez sur le bouton Ajouter>Connecter au dossier> D:\Burkinafaso_Bas-
fonds_database_FOT\Exercises\Ex-1_Displaying_Geographic_Data et ajoutez ci-dessous 
trois fichiers (deux Shapefiles/donn es vectorielles et une donn e Tiff/raster)   ArcMap.

Captures d' cran montrant les proc dures d'ajout de donn es g ographiques   ArcMap 

Vous pouvez  galement ajouter directement des couches   ArcMap en les faisant glisser 
depuis ArcCatalog. Essayez-le. 
Notez que la couche sup rieure (Burkinafaso_Regions) dans la table des mati res est affich e 
en haut de la fen tre de la vue cartographique, masquant les deux autres couches (par d faut, 
les entit s polygones sont remplies de couleurs). Dans l'exercice suivant, vous apprendrez   
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modifier la visibilit  des couhes et d'autres propri t s pertinentes (voir la section sur la 
couche de symbolisation ci-dessous). En outre, vous pouvez modifier l'ordre de dessin des 
couches en les faisant glisser vers le haut ou vers le bas. Essayez-le. 
En plus, dans la table des mati res, vous pouvez activer et d sactiver les couches pour activer 
ou d sactiver leur visibilit  dans la vue de la carte. Essayez-le. 
Pour afficher la table attributaire d'une couche d'entit s, faites un clic droit sur la 
couche>Ouvrir la table d'attributs 
Par exemple, faites un clic droit sur Burkinafaso_Bas-fonds_database> Open Attribute Table 
pour afficher la table attributaire et ses champs et donn es d'attributs dans la couche (notez 
que la capture d' cran ci-dessous montre seulement une partie de la table attributaire). 

4.1.2 Symboliser des couches 
En utilisant l'onglet Symbologie sous les propri t s de la couche, vous pouvez modifier leurs 
propri t s, y compris le symbole et le style, comme afficher un polygone avec la couleur de 
remplissage ou afficher son contour uniquement, la couleur, la largeur du contour, etc.  
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Faites un clic droit sur Burkinafaso_Regions> Propri t s (ou double-cliquez sur la couche)> 
Symbologie> Fonctions (Symbole unique)> Marqueur de symbole> Volet s lecteur de 
symbole 

Ou optionnellement, cliquez sur le marqueur Symbole (l gende) de la couche pour acc der 
directement au volet S lecteur de symboles 

Le volet Symbologie s'ouvre, vous permettant de personnaliser davantage la fa on dont la 
couche est class e et symbolis e. 

Sp cifiez ces propri t s : 
Couleur de remplissage> Aucune couleur ; Largeur de contour> 1,00 ; 
Couleur du contour> Noir et cliquez sur OK 
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Maintenant, la couleur de remplissage de la couche Burkinafaso_Regions est supprim e, 
rendant la couche visible (vous pouvez maintenant voir les polygones de la couche 
Burfinafaso_Bas-fonds dans la capture d' cran ci-dessous). 

D sactivez les deux couches sup rieures (Burkinafaso_Regions et Burkinafaso_Bas-
fonds_database), vous verrez la couche 

LC08_L1TP_195051_20161120_20170318_01_T1.TIF (imagerie Landsat), enti rement 
recouverte par ces couches sup rieures. 

Cliquez avec le bouton droit de la souris sur la couche> Zoom sur la couche pour afficher la 
couche dans toute l' tendue de la vue de la carte. 

Peut- tre avez-vous d j  remarqu  cette valeur de fond noire sur les zones frontali res de 
l'image. Vous allez rendre ces zones noires invisibles et apprendre   afficher un composite 
couleur RVB de l'image 



Manuel d'utilisation      F vrier, 2018 

III-37

  

Faites un clic droit sur la couche> Propri t s> Symbologie> Composite RVB
Voici la symbologie par d faut

 Sp cifiez ces param tres : 

  Pour rendre les valeurs d'arri re-plan invisibles, cochez la case   Afficher les valeurs 
d'arri re-plan   et sur   as   dans la liste d roulante, d finissez   Aucune Couleur   ; 

Pour un vrai composite couleur RVB, r glez Red : Band_4, Green : Band_3, Blue : Band_2 
et cliquez sur le bouton   OK   
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 La capture d' cran ci-dessous est le r sultat: 

4.1.3 Enregistrement et ouverture du document de carte (.mxd) 
Plus t t dans cet exercice, vous avez symbolis  deux couches (un vecteur et un raster). Si 
vous ne les enregistrez pas dans un document de carte, vous perdrez toute la personnalisation 
que vous avez faite la prochaine fois que vous les ajouterez   ArcMap. Pour  viter de perdre 
votre personnalisation, vous devez enregistrer ces couches dans un document cartographique. 

File>Save/Save as 
Acc dez   D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-1_Displaying_ 
Geographic_Data et donnez le nom de fichier   Displaying_Geographic_Data   et cliquez sur 
Enregistrer .  

Pour ouvrir un document cartographique la prochaine fois que vous d marrez ArcMap : 

ArcMap> Menu Fichier> Ouvrir et parcourir le fichier (par exemple 
displaying_Geographic_Data.mxd) 
Ou 
ArcCatalog> Acc dez au fichier (par exemple, Displaying_Geographic_Data.mxd) et ouvrez-
le en double-cliquant ou en cliquant avec le bouton droit et en l'ouvrant.  
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4.2  Exercice 2 - Cr ation et  dition de fichiers de formes (Shapefiles)  
Objectif d'apprentissage : 

Etre capable de cr er et  diter des fichiers Shapefiles 

Vous pouvez cr er votre propre Shapefile pour cartographier certaines caract ristiques 
g ographiques d'int r t telles que les maisons et les  tangs d'un village (entit  ponctuelle), les 
autoroutes et rivi res (entit s lin aires) et les grands lacs et les limites des bassins 
hydrographiques (caract ristique polygone). Ce tutoriel explique principalement les  tapes 
impliqu es dans la cr ation et l' dition d'un fichier de formes polygone. 

Deux passerelles communes pour la cr ation de Shapefiles sont en d marrant ArcCatalog 
depuis le menu D marrer de Windows ou en se connectant   ArcCatalog depuis une fen tre 
ArcMap. Les deux mani res sont montr es ci-dessous.

A partir ArcCatalog : 
Ouvrir ArcCatalog (  partir du menu D marrer de Windows) 

Acc dez au dossier de l'exercice (D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
2_Creating_and_Editing_Shapefiles) 
Dans le menu, cliquez sur Fichier> Nouveau> Shapefile  

[Astuce : vous pouvez  galement utiliser un menu contextuel, une op ration avec le bouton 
droit de la souris, dans un emplacement vide de la fen tre d'affichage principale (lorsque 
l'onglet Contenu est actif) pour afficher la fen tre ci-dessus   droite] 

Depuis l'int rieur d ArcMap : 

D marrer ArcMap> Cliquez sur le bouton Catalogue, une fen tre Catalogue (l g rement 
diff rente de celle ci-dessus) (  droite) appara t.
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La fen tre Catalogue affiche tous les dossiers d j  connect s   ArcMap. Par exemple, 
Burkinafaso_Bas-fonds_database_FOT est d j  connect  et accessible pour  tre ajout    
ArcMap. Toutefois, si vous vous connectez   un dossier de donn es pour la premi re fois, 
vous devez acc der au dossier en utilisant ou en cliquant sur le bouton Connecter le dossier. 

Acc dez   D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-2_Creating_and_Editing 

_Shapefiles 

Dans cette fen tre, le menu Fichier n'est pas disponible, faites un clic droit sur le nom du 
dossier (Ex-2_Creating_and_Editing_Shapefiles) un menu contextuel affiche exactement le 
m me que ci-dessus, ce qui permet de cr er un nouveau Shapefile que nous avons l'intention 
de faire. 
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Entrez l information suivante:

Nom: Plan d'eau

Type d'objet : Polygone (choisissez-le en cliquant sur la fl che d roulante) 

[Astuce 1 : si vous souhaitez cr er des entit s ponctuelles ou lin aires, d finissez Type 
d'entit  comme Point ou Polylin  respectivement   partir d'ici] 

[Astuce 2 : Le nom du champ ne doit pas d passer 10 caract res] 

  Utilisez le bouton Modifier pour s lectionner le syst me de coordonn es appropri  que 
vous utilisez dans votre projet ArcMap. Vous utiliserez les syst mes de coordonn es projet s 
-  WGS 1984 UTM Zone 30N. 

Navigation vers le syst me de projection : Syst mes de coordonn es projet s> UTM> 
WGS 1984> H misph re nord> WGS 1984 UTM Zone 30N, puis cliquez sur OK.  

Default dialog box 
After giving the 
Shapefile a Name and 
defining Feature Type
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Apr s avoir donn  le nom du Shapefile et d fini les propri t s de g om trie et de r f rence 
spatiale, la bo te de dialogue ressemble   la suivante. Puis cliquez sur OK pour terminer la 
t che.
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Remarque : si vous avez cr   le Shapefile en lan ant ArcCatalog   partir du menu D marrer 
de Windows, vous devez ajouter le Shapefile   l'aide du bouton Ajouter dans ArcMap. S'il est 
cr   dans l'interface ArcMap, il sera automatiquement ajout    ArcMap. 

Ajoutez le Shapefile Waterbody cr   (si ce n'est pas fait automatiquement) il y a quelque 
temps et LC08_L1TP_195051_20161120_20170318_01_T1.TIF   ArcMap (vous avez d j  
appris, dans Ex-2.1, comment ajouter des donn es g ographiques   ArcMap). 

En utilisant les comp tences que vous avez appris plus t t, dessinez seulement le contour de 
la couche Waterbody (c.- -d. Enlever la couleur de remplissage), la couleur contour est bleu 
fonc  et contour largeur = 2, et faites des bandes composites b5, b4 et b3 de Landsat image 

RVB (couleur fausse). La vue r sultante devrait ressembler   ceci : 

Allez au menu Signets> Zone de pratique de num risation, vous serez amen    la zone 
comme indiqu  ci-dessous 
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Ouvrez la table attributaire de la couche Waterbody, vous constaterez qu'il n'y a pas 
d'enregistrement mais seulement trois noms de champs: FID, Shape et Id (propri t s par 
d faut) 

Acc dez au bouton Editeur> D marrer l' dition (si la barre d'outils de l' diteur n'est pas 
visible, acc dez   Personnaliser> Barres d'outils> Editeur pour l'afficher) 

Si une fen tre Cr er des entit s, qui contient le nom des couches et les outils de construction 
pour esquisser ou num riser des entit s, n'est pas affich e (normalement sur le c t  droit de la 
fen tre ArcMap), cliquez sur le bouton Cr er des fonctionnalit s contenu dans la barre 
d'outils Editeur

En cliquant sur la couche Waterbody il affiche les outils de construction disponibles. 
Choisissez Polygon pour commencer la num risation des plans d'eau.



Manuel d'utilisation      F vrier, 2018 

III-45

Commencez   dessiner (en cliquant sur un intervalle de sommet appropri  pour obtenir une 
repr sentation correcte de l'entit  et de sa forme) d'un bout   l'autre. Cliquez sur votre carte 
pour placer un sommet. Vous pouvez placer plusieurs sommets pour tracer une limite de plan 
d'eau sur votre carte. Une fois le dessin termin , faites un clic droit et s lectionnez 
Terminer l'esquisse. Vous pouvez  galement double-cliquer ou appuyer sur le bouton F2. 

Deux plans d'eau dessin s sont indiqu s ci-dessous. Poursuivez la num risation pour cr er 
autant de polygones de plans d'eau que possible 
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Ouvrez la table attributaire du Waterbody, vous verrez les donn es enregistr es du syst me 
mais aucune autre information d'attribut. 

Apr s avoir fini de dessiner et/ou d'ajouter ou de mettre   jour des informations d'attributs 
dans la table, n'oubliez pas de sauvegarder votre travail. Acc dez au bouton Editeur> 
Enregistrer les modifications, puis Arr ter l' dition. 

Vous pouvez ajouter, mettre   jour et supprimer des champs d'attributs et des donn es dans la 
table. 
Dans cet exercice, vous allez ajouter un champ et calculer la superficie des plans d'eau que 
vous avez esquiss e pr c demment. 

Pour ajouter un champ, vous devez  tre en session de non- dition. Table des attributs 
ouverts> Options de la table> Ajouter un champ 

Table Options
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 Six types de donn es communs pris en charge par ArcGIS sont : 

(Adapt  de ESRI : http://www.esri.com/news/arcuser/0405/files/fieldcalc_1.pdf) 

Dans la bo te de dialogue Ajouter un champ, entrez 
Nom : Area_Ha, Type : Integer longer et cliquez sur OK.  

Faites un clic droit surle nom du champ (Area_Ha)> Calculer la g om trie

Vous verrez un message d'avertissement ci-dessous, il vous suffit de l'ignorer (cliquez sur 
Oui pour continuer) 
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Sp cifiez les unit s comme Hectares [ha], tous les autres param tres par d faut et cliquez sur 
OK. 

La surface de deux plans d'eau est calcul e. 

Comme illustr  ci-dessus, vous pouvez ajouter des champs, calculer plusieurs statistiques 
pertinentes sur la g om trie (par exemple, zone, p rim tres et centro des pour les entit s 
surfaciques). Vous pouvez  galement entrer des donn es non spatiales dans le tableau 
manuellement ou en utilisant d'autres m thodes de manipulation, de synchronisation et de 
jointure de donn es. 
Si certaines informations d'attribut dans la table attributaire ne sont plus n cessaires ou 
doivent  tre supprim es pour certaines raisons, vous pouvez les supprimer. Une mani re 
simple de les supprimer est de : 
Faire un clic droit sur l'en-t te du champ> Supprimer le champ 

Par exemple, le champ Id dans le Waterbody n'est plus n cessaire, vous pouvez le supprimer. 
Mais notez que vous ne pouvez pas supprimer (ou ne devriez pas essayer de le faire) les 
champs FID et Shape . 

Le champ Id est maintenant supprim . 



Manuel d'utilisation      F vrier, 2018 

III-49

4.3  Exercice 3   Composer des bandes  
Objectifs d apprentissage : 

Etre capable de composer des bandes

Les capteurs Landsat capturent des donn es dans diff rentes bandes de fr quence, 
correspondant   une partie du spectre  lectromagn tique (par exemple rouge visible et 
infrarouge). En combinant 3 bandes, des informations significatives peuvent  tre obtenues. 
Un composite   true color   peut  tre cr   en composant les bandes rouges [R = b4], vertes 
[G = b3] et bleues [B = b2], tandis que toutes les autres combinaisons cr ent des composites 
"fausses couleurs". 

Cette op ration cr e donc un jeu de donn es raster unique   partir de plusieurs bandes, connu 
sous le nom de Bands Compositing ou Band/Layer Stacking. Le Tableau 4.3.1 montre les 
d signations de bande et leurs longueurs d'onde correspondantes pour Landsat 8. 

Tableau 4.3.1 d signations de bande pour Landsat 8 

Trouver l'outil de composition de bandes : 

Acc dez   ArcMap/ArcCatalog, 
ArcToolbox> Outils de gestion des donn es> Raster> Traitement raster> Bandes composites

Bandes  ( m) R solution(m) 

Nom   
Bleu profond (c ti res / a rosols) 0.433   0.453  

30 

Bleu 0.452  0.512 
Vert 0.533  0.590 
Rouge 0.636  0.673 
Proche infrarouge (NIR) 0.851  0.879 
Infrarouge   ondes courtes (SWIR) 1 1.566  1.651 
Infrarouge   ondes courtes (SWIR) 2 2.107  2.294 
Panchromatique (Pan) 0.503  0.676 15
Cirrus 1.363  1.384 30
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En cliquant sur Bandes composites, vous  tes invit    entrer dans une nouvelle fen tre pour 
sp cifier des informations sur le raster en entr e et le raster en sortie. 

Entrez les informations suivantes : 

Rasters en entr e : D:\ Burkinafaso_Bas-fonds_database_FOT\ Exercises\Ex-3_Compositing_Bands\ 
LC08_L1TP_195051_20161120_20170318_01_T1 \ B1, B2, B3, B4, B5, B6, B7 (en maintenant la 
touche "Ctrl" enfonc e, s lectionnez ces sept bandes et cliquez sur le bouton   Ajouter  ) 

Raster en sortie : D:\ Burkinafaso_Bas-fonds_database_FOT\ Exercises\\Ex-3_Compositing_Bands\ 
Composite_LC08_L1TP_195051_20161120_20170318_01_T1, puis cliquez sur le bouton 
  Enregistrer  .
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Enfin, cliquez sur le bouton OK pour terminer l'op ration Bandes de composition. 

Ajoutez la bande r cemment compos e   ArcMap et effectuez diverses couleurs RVB 
composites vraies et fausses. Par exemple, ci-dessous sont les Bandes 5, 4, 3 RVB Fausse 
couleur composite.  

[Astuce : Faites un clic droit sur la couche> Propri t s> Symbologie> RVB Composite] 

T che : effectuez la composition de bande en utilisant un ensemble diff rent d'images 
Landsat D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex- 
3_Compositing_Bands\LC08_L1TP_195052_20161120_20170318_01_T1 
  
Entrez le nom de la sortie : Composite_ LC08_L1TP_195052_20161120_20170318_01_T1 

Vous utiliserez le raster en sortie (deux bandes composites) dans les exercices suivants pour 
cr er une image mosa qu e
  

7
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4.4  Exercice 4 - mosa quage des Images  

Objectifs d apprentissage : 

 Etre capable de mosa images 

Le mosa quage des images est une technique de traitement d'image permettant de masquer 
des images matricielles pour former une grande image de sorte que les limites entre les 
images d'origine soient parfaitement m lang es ou non visibles. 

Trouver l'outil Images : 
Acc dez   ArcMap/ArcCatalog 
ArcToolbox> Outils de gestion des donn es> Raster> Jeu de donn es raster> Mosa que vers 
Nouveau raster 

Remarque : ArcGIS dispose de deux outils similaires pour effectuer le mosa quage d'images. 
Le premier est Mosaic to New Raster et l'autre est Mosaic. L'outil Mosaic to New Raster
fusionne plusieurs jeux de donn es raster dans un nouveau jeu de donn es raster tandis que 
l'outil Mosaic fusionne plusieurs jeux de donn es raster dans un jeu de donn es raster existant. 
Ne soyez pas confus ! Dans cet exercice, nous cr ons un nouveau jeu de donn es raster, de 
sorte que vous utiliserez l'outil Mosaic to New Raster. 
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En cliquant sur l'outil Mosaic To New Raster, vous  tes invit  dans une nouvelle fen tre pour 
sp cifier des informations sur Input raster et Output raster. 

Entrez les informations suivantes : 

Raster en entr e : 

Allez dans D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-4_Mosaicking_Images et 
ajoutez ces deux images Landsat 

Composite_LC08_L1TP_195051.TIF et 
Composite_LC08_L1TP_195052.TIF
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Emplacement de sortie : 
D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-4_Mosaicking_Images 

Nom de base de donn es raster avec extension : 
Mosaicked_LC08_L1TP_195051_n_LC08_L1TP_195052.TIF 

R f rence spatiale pour raster (optionnel) : WGS 1984 UTM Zone 30N 

Type de pixel (facultatif) : 16_BIT_UNSIGNED (identique aux donn es source) 

Taille de cellule (facultatif) : 30 

Nombre de bandes : 7 ( gal aux donn es source) 

Autre param tre : par d faut
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Comparez les donn es et les r sultats avant et apr s le mosa quage de l'image. 

Deux images Landsat avant le mosa quage 
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Une seule image Landsat apr s le mosa quage d'image

Notez que deux images sont parfaitement m lang es le long des limites et de la partie de 
chevauchement. 
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4.5  Exercice 5 - G otraitement 

Objectifs d'apprentissage : 
Etre capable de couper des donn es
Etre capable d effectuer des op rations de g otraitement vectorielles telles que la 
dissolution et la mise en m moire tampon

4.5.1 Cr ation de donn es de sous-ensemble 
La cr ation de sous-ensemble ou de d coupage raster est le processus par lequel un sous-
ensemble du jeu de donn es raster est cr  , supprimant les donn es hors de la zone d'int r t 
(AOI) r duisant la taille du fichier et am liorant le temps de traitement de nombreuses 
op rations de g otraitement.

Il existe plusieurs m thodes ou outils permettant de cr er un sous-ensemble de donn es 
(d couper une partie d'une image ou d'un raster) dans ArcGIS, notamment   l'aide des outils 
Clip et Extraire par asque (polygone ou masque raster). Dans cet exercice, l'outil Clip est 
utilis  pour cr er une image de sous-ensemble. Explorez d'autres fa ons par vous-m mes.

Trouver l'outil Clip :

Acc dez   ArcMap/ArcCatalog

ArcToolbox> Outils de gestion des donn es>Raster>Traitement raster>Clip 
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Supposons que votre zone d'int r t pour la collecte et l'analyse de donn es est uniquement la 
r gion du Centre. Vous n'avez pas besoin de charger une image Landsat de grande taille en 
dehors de cette zone. Dans cet exercice, vous cr ez une image sous-ensemble des donn es 
Landsat de la r gion du Centre du Burkina Faso. 



Manuel d'utilisation      F vrier, 2018 

III-59

Entrez les informations suivantes : 

Raster en entr e : 
D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
5_Creating_Subset_Data\Mosaicked_LC08_L1TP_195051_n_LC08_L1TP_195052 

Sortie Extension (facultatif) : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
5_Creating_Subset_Data\ROI_training 

Cochez la case : Utiliser la fonction d'entr e pour la g om trie e coupage (facultatif) 

Jeu de donn es en sortie : 
D:\ Burkinafaso_Bas-fonds_database_FOT \ Exercises \ Ex-5_Creating_Subset_Data 
\ Subset_LC08_Centre_region_Burkinafaso.TIF 

Valeur NoData (facultatif): 0 
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Le sous-ensemble r sultant de l'image Landsat de la r gion du Centre est vu comme ceci : 

L'image du sous-ensemble a env. une taille de fichier de 90 Mo par contraste env. 1,5 Go de 
donn es d'entr e. 

4.5.2 Op rations de g otraitement vectoriel 
A l'aide d'ArcGIS, vous pouvez effectuer un certain nombre d'op rations de g otraitement 
telles que Dissoudre, Mettre en m moire tampon, Union, Couper, Effacer, Fusionner et 
Ajouter. Dans cette sous-section, les op rations Dissoudre et Mettre en m moire tampon 
seront exerc es 

(1) Dissoudre 
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(2) Tampon  

(3) Union 

(4) Couper 

(5) Effacer 

(6) Fusionner 

(7) Ajouter 

(Adapt  de ArcGIS, Aide) 



Manuel d'utilisation      F vrier, 2018 

III-62

4.5.2.1 Dissoudre 
Dans cet exercice, vous dissolvez 13 r gions du Burkina Faso pour faire une fronti re de pays 
agr g e. 

Trouver l'outil Dissoudre : 
Acc dez   ArcMap/ArcCatalog 
Menu de g otraitement>Dissoudre 
[Ou acc dez   ArcToolbox>Outils de gestion des donn es>G n ralisation>Dissoudre
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Lorsque vous cliquez sur l'outil Dissoudre, vous  tes invit    ouvrir une bo te de dialogue 
Dissoudre 

Entrez les informations suivantes : 

Fonctionnalit s en entr e : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises Ex- 

5_Geoprocessing 4.5.2_ Vector  

Based_ Geoprocessing_Operations_\ 4.5.2.1_Dissolving\13_regions_of_Burkinafaso 

Classe de Fonctionnalit s en sortie : \Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
5_Geoprocessing\4.5.2_Vector-
based_Geoprocessing_Operations\4.5.2.1_Dissolving\Disolved_regions  

Dissoudre le (s) champ (s) (optionnel) : FID 

Les r gions dissoutes r sultantes (= fronti re du Burkina Faso) ressemblent   ceci : 
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4.5.2.2 Mettre en m moire tampon 
Dans cet exercice, vous faites un tampon de 5 km autour des routes pav es au Burkina Faso 
et plus tard superposez la base de donn es Bas-fonds pour voir o , quels ou combien de Bas-
fonds sont situ s dans une zone tampon de 5 km qui vous aide   analyser ou   prendre une 
d cision quant   la pertinence du d veloppement de Bas-fonds dans le futur. 

 La capture d' cran ci-dessous montre des routes pav es (de couleur marron fonc ) au 
Burkina Faso. 

Trouver l'outil Tampon : 
Allez   ArcMap 
ArcToolbox>Outils d'analyse>Proximit >Tampon
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Lorsque vous cliquez sur l'outil Tampon, la bo te de dialogue suivante appara t 
D finissez les  l ments suivants : 

Caract ristiques en entr e : 

D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-5_Geoprocessing\4.5.2_Vector-
based_Geoprocessing_Operations\4.5.2.2_Buffering\Road_paved 

Classe de fonctionnalit s en sortie : 

D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-5_Geoprocessing\4.5.2_Vector-
based_Geoprocessing_Operations\4.5.2.2_Buffering\Road_paved_Buffer5km 

Distance [valeur ou champ] : 

Unit  lin aire : 5 Kilom tres (  partir de la fl che d roulante, choisissez Kilom tres comme 
unit ) 
Dissoudre le (s) champ (s) (facultatif) : FID 

Tous les autres param tres : Par d faut 
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La couche tampon r sultante (Road_paved_Buffer5km) ressemble   ceci. 

Ajouter la couche de base de donn es Bas-fonds (vous pouvez la trouver dans le m me 
dossier que celui de la couche Tampon). Supprimez la couleur de remplissage de la couche de 
base de donn es Bas-fonds et d crivez-la avec une couleur marron clair comme illustr  ci-
dessous. 

La couche tampon et la couche de base de donn es Bas-fonds superpos es ressemblent   ceci 

Une vue rapproch e de la zone, affich e avec une bo te rouge au-dessus, est affich e ci-
dessous. 
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Tous les Bas-fonds qui se trouvent   l'int rieur d'une zone tampon de 5 km autour des routes 
pav es au Burkina Faso sont indiqu s ci-dessous. 

Une vue rapproch e de la zone, affich e avec une bo te rouge au-dessus, est affich e ci-
dessous  
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4.6 Exercice 6 - Calcul des indices spectraux 

Etre capable de calculer l'Indice de l'Eau par Diff rence Normalis e (NDWI) et
Etre capable de calculer l'Indice de V g tation par Diff rence Normalis e (NDVI)

4.6.1 Calcul du NDWI 
Le NDWI a  t  propos  par Gao (1996). L'indice spectral  tait   l'origine destin     tre utilis  
pour surveiller les changements dans la teneur en eau des feuilles, mais il a des applications 
plus larges pour l'identification de l'eau ou des organismes li s   l'eau tels que les zones 
humides et Bas-fonds. Le NDWI utilise les longueurs d'onde infrarouge proche (NIR) et   
ondes courtes (SWIR).  

La formule est: NDWI = (Green - SWIR) / (Green + SWIR).

NDWI utilisant Landsat 8 = (Green   SWIR1) / (Green + SWIR1) = (B3-B6) / (B3+B6) 

Trouver la fonction NDWI : 
Aller   ArcMap 
ArcToolbox> Outils d'analyse spatiale>Alg bre cartographique>Calculatrice raster 

Cliquez sur Outils Spatial Analyst et Alg bre cartographique pour lancer l'outil 
  Calculatrice raster  . 
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Au d but, ajoutez des donn es raster (B3 et B6)   ArcMap 

Dossier de donn es : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
6_Computing_Spectral_Indices  

Lorsque vous cliquez sur Raster Calculator, une nouvelle bo te de dialogue s'affiche, qui 
affiche par d faut les bandes 3 et 6 sous l'expression Map Algebra. Entrez les donn es dans 
la commande conform ment   l' quation suivante (B3-B6/B3+B6). 

(B3-B6/B3+B6)
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Raster en sortie : 

D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
6_Computing_Spectral_Indices\ndwi.TIF 

Enregistrez la production et cliquez sur "OK". 

L'image NDWI est affich e comme indiqu  ci-dessous.

Pour symboliser (par exemple, changer la couleur de la carte), la carte ndwi, 
Clic droit sur couche ndwi> Propri t s 
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Aller   l'onglet Symbologie> Classifi  

Cliquez sur n'importe quelle combinaison de couleurs de la rampe de couleurs (r glez la 
combinaison de couleurs pr sent e ici pour voir la carte ndwi ci-dessous). Vous pouvez 
choisir n'importe quelle couleur ou changer la couleur individuelle de la barre d'index de 
couleur. Et cliquez sur OK. 
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La carte ndwi symbolis e r sultante ressemble   ceci

4.6.2 Calcul du NDVI 

L'indice de v g tation par diff rence normalis e (NDVI) est un indice spectral normalis  qui 
g n re une image montrant la verdure (c'est- -dire la biomasse relative). 
La formule est : 

NDVI = (NIR - Red) / (NIR + Red) 

NDVI utilisant Landsat 8 = (B5-B4) / (B5+B4) 

Trouver la fonction NDVI : 
Aller   ArcMap 
ArcToolbox> Outils d'analyse spatiale> Alg bre cartographique>Calculatrice Raster

Ajouter des donn es raster (B4 et B5)   ArcMap 
Dossier de donn es  D:\Burkinafaso_Bas-fonds_database_FOT Exercises\Ex-
6_Computing_Spectral_Indices
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Lorsque vous cliquez sur Raster Calculator, une nouvelle bo te de dialogue s'affiche, qui 
affiche par d faut les bandes 4 et 5 sous l'expression Map Algebra. Entrez les donn es dans 
la commande conform ment   l' quation suivante (B5-B4/B5+B4).  

Raster en sortie :  

D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
6_Computing_Spectral_Indices\ndvi.TIF 

Enregistrez la production et cliquez  OK . 

L'image NDVI de la production ressemble   celle montr e ci-dessous 

(B5-B4/B5+B4)
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En r p tant les  tapes expliqu es pour symboliser l'image ndwi, vous symboliserez l'image 
ndvi (vous pouvez utiliser exactement la m me combinaison de couleurs que celle montr e 
ci-dessous ou diff rente de vous-m me), essayez-le.

 La carte ndvi symbolis e r sultante ressemble   ceci : 
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4.7 Exercice 7 - D rivation d clivit  

Objectif d apprentissage : 
 Etre capable de calculer le gradient de pente   l'aide du mod le d' l vation num rique 

(DEM) 

Dans cet exercice, vous utiliserez SRTM DEM (90 m).

Trouver l'outil   Slope   : 
Acc dez   ArcMap/ArcCatalog, 
ArcToolbox> Outils Spatial Analyst> Surface> Pente

En cliquant sur l'outil   Pente   vous invite   une nouvelle fen tre pour fournir les donn es et 
les param tres d'entr e et de sortie n cessaires :

1

2

3

4
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Assurez-vous de fournir les informations suivantes : 

Raster en entr e : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
7_Deriving_Slope_Gradient\Slope\ Burkinafaso_AOI_SRTM.tif 

Raster de sortie : D : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
7_Deriving_Slope_Gradient\Slope\Burkinafaso_AOI_slope.tif 

Mesure de sortie : Percent_Rise 

Facteur de zone : 1 

Enfin, cliquez sur le bouton OK pour terminer l'op ration de calcul de la pente. Au-dessous 
de la carte sont les r sultats (carte de pente). Naviguez (en zoomant et en panoramique) sur la 
carte pour voir la distribution des pentes   Bas-fonds 
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Voici la carte des pentes de la R gion du CENTRE d riv e de SRTM DEM. Les Bas-fonds 
sont superpos s sur la carte des pentes. 
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4.8 Exercice 8 - Calcul des statistiques de zone 

Objectif d apprentissage : 
 Etre capable de Calculer des statistiques de zone 

Une zone correspond   toutes les cellules d'un raster ayant la m me valeur, qu'elles soient 
contigu s ou non (ArcGIS Desktop Help). La couche de zone d'entr e d finit la forme, les 
valeurs et les emplacements des zones. 

Il y a deux outils dans ArcGIS,   savoir Statistiques zonales et Statistiques zonales sous 
forme de Tableau pour effectuer l'analyse zonale des cellules. 

Avec l'outil Statistiques zonales, une statistique est calcul e pour chaque zone d finie par 
un ensemble de donn es de zone, en fonction des valeurs d'un autre ensemble de donn es (un 
raster de valeur). Une seule valeur de sortie est calcul e pour chaque zone de l'ensemble de 
donn es de zone d'entr e (tel que d fini par l'utilisateur). 

Alors que l'outil Statistiques Zonales comme Tableau calcule tout, un sous-ensemble ou une 
seule statistique valide pour l'entr e sp cifique mais renvoie le r sultat sous la forme d'un 
tableau au lieu d'un raster en sortie

(Source : ArcGIS Desktop Help) 
Figure 4.8.1 Exemple de raster d'entr e et de sortie   l'aide de l'outil Statistiques zonales 
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Le type de donn es de sortie est d termin    la fois par le type de statistique s lectionn  et le 
type d'entr e de valeur. Les types de donn es attendus du raster en sortie sont les suivants : 

Majorit  : la valeur la plus fr quente dans chaque zone est attribu e   toutes les cellules de 
cette zone. 
Maximum : La valeur la plus  lev e de chaque zone est attribu e   toutes les cellules de cette 
zone. 
Moyenne : La moyenne des valeurs de chaque zone est affect e   toutes les cellules de cette 
zone. 
M diane : La m diane des valeurs de chaque zone est affect e   toutes les cellules de cette 
zone. 
Minimum : La valeur la plus faible de chaque zone est affect e   toutes les cellules de cette 
zone. 
Minorit  : la valeur la moins fr quente dans chaque zone est affect e   toutes les cellules de 
cette zone. 
Plage : La diff rence entre les valeurs maximale et minimale dans chaque zone est affect e   
toutes les cellules de cette zone. 
 cart-type : L' cart-type des valeurs de chaque zone est affect    toutes les cellules de cette 
zone. 
Somme : La somme de toutes les valeurs de cellule dans chaque zone est affect e   toutes les 
cellules de cette zone. 
Vari t  : Le nombre de valeurs uniques dans chaque zone est attribu    toutes les cellules de 
cette zone. 

Remarque : Si un emplacement de cellule sur l'ensemble de donn es de la Zone est NoData, 
NoData sera affect    cet emplacement sur la sortie. 

Dans cet exercice, les polygones SRTM DEM et Bas-fonds de la r gion du CENTRE sont 
utilis s pour calculer les statistiques zonales (statistiques zonales sous forme de tableau, c'est-
 -dire que la sortie est un tableau avec tous les types de donn es possibles). 

Trouver l'outil d'analyse zonal : 
Allez dans ArcMap/ArcCatalog, puis 
ArcToolbox> Outils Spatial Analyst> Zone> Statistiques zonales sous forme de tableau 
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Cliquer sur Statistiques zonales sous forme de Tableau vous invite   ouvrir une nouvelle 
fen tre pour fournir les donn es/informations d'entr e et de sortie n cessaires : 

4

3

2

1
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Entrez les informations suivantes : 

Donn es d'entr e raster ou de zone d'entit s : D:\Burkinafaso_Bas-
fonds_database_FOT\Exercises\Zonal 
_Statistics\ROI_BFs_training.shp 
  
Champ de zone : FID 

Valeur en entr e raster : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
8_Calculating_Zonal 
_Statistics\Zonal_Statistics\Burkinafaso_AOI_SRTM.tif 

Tableeau en sortie : D:\Burkinafaso_Bas-fonds_database_FOT\Exercises\Ex-
8_Calculating_Zonal 
_Statistics\Zonal_Statistics\zontalstatisticstable 

Type de statistiques : Tous

Enfin, cliquez sur le bouton OK pour terminer l'op ration. 

Ensuite, allez   la table des mati res> s lectionnez Liste par source> 
zonalstatisticstable>faites un clic droit sur la couche> ouvrir, pour voir les donn es de sortie. 

Voici la sortie de Statistiques zonales en tant que Tableau. 

De nombreux attributs de la base de donn es Bas-fonds, notamment Altitude minimale, 
Altitude maximale, Altitude moyenne et autres, ont  t  extraits du jeu de donn es raster 
appropri  (attributs de l'ensemble de donn es DEM, attributs de pente du jeu de donn es 
pente, attributs de sol de l'ensemble de donn es sur les sols et ainsi de suite).  

1

2

3
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